## Contents

_About This Book_ ................................................................. ..v
_What's New in SAS Model Manager 12.3_ ................................. vii
_Accessibility Features of SAS Model Manager_ ........................... ix
_Recommended Reading_ ......................................................... xi

**Chapter 1 • Introduction to SAS Model Manager Administrator's Guide** ................................................................. 1
  Overview of SAS Model Manager Administration ........................... 1

**Chapter 2 • Pre-Installation Tasks** ........................................... 3
  Overview of Pre-Installation Tasks ........................................... 3
  Create an Operating System Account for Product Administrators and Users .... 3
  Determine the Location of the SAS Environment File .......................... 5
  Configure the SAS Model Manager Database ................................ 5

**Chapter 3 • Preparing SAS Model Manager for Use** ......................... 7
  Overview of Preparing SAS Model Manager for Use .......................... 8
  Post-Installation Verification and Configuration of SAS Model Manager ....... 8
  Creating Operating System Accounts in UNIX Environments .................. 10
  Configuring a SAS Application Server ...................................... 12
  Enabling the SAS Workspace Server XCMD Option ........................... 13
  Configuring the Dashboard Reports Directory ................................ 13
  Configuring Model Manager Java Services Options .......................... 15
  Configuring and Using Java Web Start ...................................... 21
  Configuring the Limitation on the Number of Observations for a Scoring Result Set . 22
  Configuring SAS Workflow for Use with SAS Model Manager ................. 22

**Chapter 4 • Setting Up SAS Management Console for Use** ................ 31
  Overview of Setting Up SAS Management Console for Use ................... 31
  Configuring a SAS Model Manager Connection Profile for the SAS Metadata Repository ......................................................... 32
  Configuring Users, Groups, and Roles ...................................... 34
  Configuring Alert Notifications for SAS Workflow ........................... 43
  Create Model Manager Libraries in SAS Management Console ............... 44
  Creating a New Table Using SAS ............................................ 46
  Registering a Table Using SAS Management Console ........................ 47
  Verify Accessibility of Data Tables in SAS Model Manager .................. 50

**Chapter 5 • Creating and Configuring Publication Channels** ............... 51
  Overview of Creating and Configuring Publication Channels ................. 51
  Define an HTTP or HTTPS Server .......................................... 53
  Define Publish Locations for the SAS Content Server ........................ 54
  Configuring Channels and Subscribers for SAS Model Manager .............. 55
  Create a Channel Folder .................................................... 57
  Create a New Channel ................................................................ 58
  Create a New Subscriber ...................................................... 58
  Modify an Existing Channel or Channels Node Location ...................... 60
About This Book

Audience

SAS Model Manager Administration is for the following users:

- Those who are responsible for administering SAS Model Manager.
- Those who are responsible for administering the SAS Metadata Repository for use with SAS Model Manager.

You might be assigned to a specific user group or role. That assignment determines which tasks you can perform. For more information, see “Configuring Users, Groups, and Roles” on page 34.

Prerequisites

Here are the prerequisites for administering SAS Model Manager:

- The following software must be installed on your computer:
  - Java Development Kit v1.7.0_17
  - SAS Web Server and SAS Web Application Server
  - SAS Management Console 9.4
  - SAS Model Manager Client 12.3

  For more information, see SAS Intelligence Platform: Installation and Configuration Guide

- You must have a user ID and password for logging in to SAS Management Console and SAS Content Server Administration Console.

Conventions Used in This Document

The following typographical conventions are used for all text in this document except for syntax:

**bold**

identifies an item in the SAS Model Manager window or a menu item.
The following typographical conventions are used in syntax:

**bold**
identifies the name of a macro.

*italic*
identifies an argument that must be supplied by the user.

< >
identifies an optional macro argument.

| (vertical bar)
indicates that you can choose one value from a group. Values that are separated by the vertical bar are mutually exclusive.

**UPPERCASE**
indicates a keyword that can be used as a value for an argument.
What's New in SAS Model Manager 12.3

Overview

The *SAS Model Manager: Administrator's Guide* contains new and updated administrative tasks that are associated with SAS Model Manager.

SAS Model Manager administrative tasks have the following new features and enhancements:

- post-installation configurations
- configurations for Model Manager Java Services options

Post-Installation Configurations

Additional steps were added to the post-installation verification and configuration steps. The steps added are for configuring multiple SAS Application Servers, and for configuring the SAS Web Server to use HTTPS and Secure Sockets Layer (SSL) certificates. The step for modifying the -JREOPTIONS parameter and the JGroups bind address has been removed because it does not apply for SAS 9.4. For more information, see “Post-Installation Verification and Configuration of SAS Model Manager” on page 8.

Configurations for Model Manager Java Services Options

More options have been added to the Model Manager Java Services Options setting in SAS Management Console. Additional settings can be modified for report options and performance options for the High-Performance Analytics procedure. For more information, see “Configuring Model Manager Java Services Options” on page 15.
SAS Model Manager 12.3 has been tested with assistive technology tools. It includes accessibility and compatibility features that improve the usability of the product for users with disabilities, with exceptions noted below. These features are related to accessibility standards for electronic information technology that were adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973 (2008 draft proposal initiative update). Applications are also tested against Web Content Accessibility Guidelines (WCAG) 2.0, part of the Web Accessibility Initiative (WAI) of the Worldwide Web Consortium (W3C). For detailed information about the accessibility of this product, send e-mail to accessibility@sas.com or call SAS Technical Support.

For more information about accessibility features and exceptions, see “Accessibility Features of SAS Model Manager” in SAS Model Manager: User's Guide.
Accessibility Features of SAS Model Manager
Recommended Reading

Here is the recommended reading list for this title:

• The online Help for the SAS Model Manager.
• *SAS Model Manager: User's Guide*
• *SAS Workflow Studio: User's Guide*
• *SAS In-Database Products: Administrator's Guide*
• *SAS Intelligence Platform: Installation and Configuration Guide*
• *SAS Intelligence Platform: Middle-Tier Administration Guide*
• *SAS Intelligence Platform: Desktop Application Administration Guide*
• *SAS Intelligence Platform: System Administration Guide*
• *SAS Intelligence Platform: Web Application Administration Guide*
• *SAS Publishing Framework: Developer's Guide*

For a complete list of SAS books, go to support.sas.com/bookstore. If you have questions about which titles you need, please contact a SAS Book Sales Representative:

SAS Books
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-3228
Fax: 1-919-677-8166
E-mail: sasbook@sas.com
Web address: support.sas.com/bookstore
Chapter 1
Introduction to SAS Model Manager Administrator's Guide

Overview of SAS Model Manager Administration

The SAS Model Manager: Administrator's Guide provides pre-installation tasks for SAS Model Manager 12.3 on SAS 9.4, and explains how to prepare SAS Model Manager for use and how to manage information that is associated with SAS Model Manager. The administrator uses SAS Management Console to access metadata repositories that store information about SAS Model Manager users, libraries, data tables, and the Publishing Framework. Frequently used administrative and configuration tasks are included in this guide to provide guidance after the SAS Model Manager installation process is completed. The high-level tasks include the following:

• Completing pre-installation and configuration tasks for SAS Model Manager
• Completing post-installation verification and configuration steps for SAS Model Manager
• Preparing a database for use with SAS Model Manager
• Setting up SAS Management Console for use with SAS Model Manager
• Creating and configuring published channels
• Managing data tables, users, groups, and roles
• Configuring directory permissions
Chapter 2
Pre-Installation Tasks

Overview of Pre-Installation Tasks

Before you install SAS Model Manager 12.3 on SAS 9.4, you must perform pre-installation tasks. The following topics explain pre-installation and configuration tasks that must be completed in addition to the SAS 9.4 pre-installation tasks that must be completed before or during the SAS Model Manager installation and configuration process.

• “Create an Operating System Account for Product Administrators and Users” on page 3
• “Determine the Location of the SAS Environment File” on page 5
• “Configure the SAS Model Manager Database” on page 5

Create an Operating System Account for Product Administrators and Users

About the User Accounts for SAS Model Manager

SAS Model Manager provides two types of user accounts:

Product administrator

A SAS Model Manager administrative user is specific to SAS Model Manager. A product administrator account is not the same as a general administrator account,
such as the SAS Administrator (sasadm@saspw). These users must have a valid host
operating system account, and you must associate that account with a metadata user.
You must create the operating system account for the administrator as a pre-
installation task. For more information, see “Create Windows Operating System
Accounts and Groups for Users of SAS Model Manager” on page 4.

Users of SAS Model Manager
These users must have a valid host operating system account, and you must associate
that account with a metadata user through SAS Management Console.
You can create regular user accounts for SAS Model Manager as a post-installation
task. For more information, see “Configuring Users, Groups, and Roles” on page 34.

Create Windows Operating System Accounts and Groups for Users
of SAS Model Manager

On the SAS Workspace Server, create an operating system account for the administrator
of SAS Model Manager (for example, mdlmgradmin) and all SAS Model Manager
users.
If the SAS Workspace Server is running Windows, use one of the following methods to
create this operating system account:
• If you are working on a local machine, complete these steps to create this user
account:
1. If you are running in a Windows operating system environment, right-click the
Computer icon on your desktop and select Manage. The Computer Management
dialog box appears.
2. In the left navigation pane, expand the Local Users and Groups node. The
Users and Groups nodes appear.
3. Right-click the Users node and select New User. The New User dialog box
appears.
4. In this dialog box, complete these tasks:
   • Specify a user name and password.
   Note: In Windows, you cannot enter <domain>\username (you enter the user
   name only), but you must enter <domain>\username in the SAS Deployment
   Wizard and SAS Management Console.
   • Clear the User must change password at next logon check box.
   • Select the User cannot change password check box.
   • Select the Password never expires check box.
   Click Create.
5. Click Close to close the New User dialog box.
6. If you want to add the users that you created to a group, perform the follow steps:
   a. Right-click the Groups node in the Computer Management dialog box, and
      select New Group.
   b. Click Add. Enter the user names, separated by semicolons, and click Check Names.
   c. Click OK.
7. Assign the security policy of Log on as batch job for each user or group.
   b. From the Local Security Policy window, expand the Local Policies node and select User Rights Assignment. Then double-click the Log on as batch job policy.
   c. Click Add user or Group. Enter the user names or group names, separated by semicolons, and click Check Names.
   d. Click OK.
   • Define the user (for example, <domain>\username) on the Active Directory server.

Create UNIX Operating System Accounts and Groups for Users of SAS Model Manager

You can create the SAS Model Manager UNIX user group as a pre-installation or post-installation task. For more information, see “Creating Operating System Accounts in UNIX Environments” on page 10.

Determine the Location of the SAS Environment File

During deployment of SAS Model Manager, you are prompted by the SAS Deployment Wizard to specify the location of the SAS environment file (named sas-environment.xml). An example is http://<server>:<port>/sas/sas-environment.xml). This file defines a set of SAS deployments at your site for client applications to use. The sas-environment.xml file does not need to physically exist at the location that you specify in the SAS Deployment Wizard before beginning the SAS installation. However, knowing the intended location of this file is important because every client installation is prompted for this value. If you do not specify the correct URL for the SAS environment file during deployment, then you must manually specify the URL in a file on every client. As a best practice during your planning process, determine a URL and share it with administrators who perform installations.

For more information about the structure of this file, see “Configuring the SAS Environment File” in Chapter 1 of SAS Intelligence Platform: Middle-Tier Administration Guide.

Configure the SAS Model Manager Database

The SAS Model Manager database is used to store operational, historical, and auditing data for SAS Model Manager. By default, during deployment of SAS Model Manager 12.3 on SAS 9.4, the SAS Deployment Wizard creates and configures the SAS Model Manager database to use the SAS Web Infrastructure Platform Data Server. You can use another third-party database server with SAS 9.4. In SAS 9.4 the following third-party database management systems are supported for the SAS Model Manager database: IBM DB2, MySQL, Oracle, PostgreSQL, and Microsoft SQL Server. SAS Web Infrastructure Platform Data Server cannot be configured manually. All of the third-
party database servers must be installed manually. For information about the versions of the alternative databases that are supported, see “Reviewing Third-Party Database Requirements” in Chapter 6 of SAS Intelligence Platform: Installation and Configuration Guide.

The SAS Model Manager database is created automatically during the installation and configuration process for the SAS Web Infrastructure Platform Data Server, MySQL, and Microsoft SQL Server database types. The default name for the SAS Model Manager database is MdlMgrDB. The default database name cannot be changed when using the SAS Web Infrastructure Platform Data Server, but can be changed when using a third-party database type. For the remaining database types, PostgreSQL, Oracle, and IBM DB2, the SAS Model Manager database must be created manually by the database administrator before completing the Software Deployment Wizard configuration step.

For the SAS Web Infrastructure Platform Server, the SAS Model Manager database tables are automatically created and loaded when the database is created. For third-party database types, the SAS Deployment Wizard can create and load the tables that are needed by SAS Web Infrastructure Platform Services and SAS Model Manager. When using a third-party database type, select the Automatically create tables and load data check box to use this feature. If you prefer to create the tables yourself for the SAS Model Manager database when using a third-party database type, then clear the check box and submit the SQL statements after the wizard finishes running. The SQL statements are in the file CreateMMTables.sql, which is located in the SAS-installation directory\SASModelManagerMidTier\12.3\Config\Deployment\Content\dbscript\<database-type> directory.

If you prefer to use a third-party vendor database instead of SAS Web Infrastructure Platform Data Server, then the SAS Model Manager database must be configured with the tables and data that are needed by SAS Model Manager. The JDBC connection information for the database must be provided to the SAS Deployment Wizard. The following information must be provided for the SAS Model Manager database:

- Host name of the database server
- Port number of the database server or listener
- Database name or Oracle System Identifier (SID)

  Note: Some databases, such as PostgreSQL are case sensitive.
- User ID, password, and schema (if applicable)
- Directory location of JDBC drivers for the database

For database-specific information about configuring a database, see SAS Intelligence Platform: Installation and Configuration Guide.
Chapter 3
Preparing SAS Model Manager for Use

Overview of Preparing SAS Model Manager for Use .................................. 8
Post-Installation Verification and Configuration of SAS Model Manager ........ 8
Creating Operating System Accounts in UNIX Environments .................... 10
  Using Operating System Groups to Assign Permissions ......................... 10
  Conditions for the User Group for SAS Model Manager ....................... 11
  Update the SAS Scripts to Grant Permissions to the User Group ............ 11
Configuring a SAS Application Server .................................................. 12
Enabling the SAS Workspace Server XCMD Option .................................. 13
Configuring the Dashboard Reports Directory ........................................ 13
Configuring Model Manager Java Services Options .................................. 15
  Overview of Configuring Model Manager Java Services Options ............... 15
  Report Options ............................................................................. 16
  Publish Scoring Options ............................................................. 16
  Debug Options .......................................................................... 17
  Valid Variable Name Options ....................................................... 17
  In-Database Options ................................................................... 17
  Performance Options ................................................................. 19
Configuring and Using Java Web Start ...................................................... 21
Configuring the Limitation on the Number of Observations for a Scoring Result Set .................................................................................. 22
Configuring SAS Workflow for Use with SAS Model Manager ................. 22
  Overview ...................................................................................... 22
  Guidelines for Creating Workflow Definitions ................................... 23
  How to Associate a Model Management Component with a Workflow Activity ............................................................... 24
  How to Associate a Milestone with a Workflow Activity ...................... 26
  How to Make Workflow Definitions Available to SAS Model Manager .... 28
Log On to the Server ........................................................................... 29
Add Tag Attributes to a Workflow Definition .......................................... 29
Upload a Workflow Definition ............................................................ 29
Verify That the Workflow Definitions Are Available in the Workflow Console . 30
Overview of Preparing SAS Model Manager for Use

After installing and configuring SAS Model Manager, you must perform additional tasks to prepare SAS Model Manager for use.

- Verify that all installation and configuration steps have been completed. Perform any required additional configuration steps for the installed SAS solutions.
- If necessary, prepare a database to use with SAS Model Manager.

*Note:* This task needs is required only if you have SAS Scoring Accelerator installed.

For more information about installation and configuration, see the SAS Knowledge Base/Install Center at [http://support.sas.com/documentation/installcenter/](http://support.sas.com/documentation/installcenter/).

Post-Installation Verification and Configuration of SAS Model Manager

After you install SAS 9.4 and SAS Model Manager 12.3 using SAS Software Depot, you must perform additional configuration steps before you can use SAS Model Manager.

1. Verify that all installation and configuration steps in the instructions.html file have been completed. The instructions.html file is located in `\sasconfigdir\Lev# \Documents\`.

2. The SAS Deployment Wizard does not create SAS Model Manager users by default. The SAS Administrator must create users in SAS Management Console with the appropriate group and role permissions. Verify that all users who were created during the installation process to use SAS Model Manager are granted the appropriate permissions to the SAS Workspace Server. In a Windows environment, each user or group must be granted permission to the *Log on as a batch job* local security policy. For more information, see “Create Windows Operating System Accounts and Groups for Users of SAS Model Manager” on page 4.

   In a UNIX environment all SAS Model Manager users must be part of a group that has the appropriate group permissions. For more information, see “Creating Operating System Accounts in UNIX Environments” on page 10 and “Configuring Users, Groups, and Roles” on page 34.

3. SAS Model Manager 12.3 on SAS 9.4 provides support for the use of multiple SAS Application Servers to be used when defining a performance task, a scoring task, or a model retrain task. If you want to use a SAS Application Server other than the default `SASApp`, you must configure the other SAS Application Server using SAS Management Console. For more information, see “Configuring a SAS Application Server” on page 12.

4. If the SAS Workspace Server is located in a UNIX environment, you must enable the SAS Workspace Server XCMD option in order to support R model functionality. For more information, see “Enabling the SAS Workspace Server XCMD Option” on page 13.
5. During installation, if you chose to perform a manual configuration of the SAS Model Manager database, or you chose a third-party database vendor that does not support automated creation of tables and loading of data, additional configuration steps are required. For more information, see “Configure the SAS Model Manager Database” on page 5.

6. If the SAS Scoring Accelerator or SAS Model Manager In-Database Scoring Scripts products are a part of your SAS 9.4 deployment, additional configuration steps are required to prepare the database for publishing and scoring in SAS Model Manager. For more information, see “Preparing a Database for Use with SAS Model Manager” in Chapter 10 of *SAS In-Database Products: Administrator's Guide*.

7. During installation and configuration of SAS 9.4, the SAS Deployment Wizard enables you to configure the SAS Web Server to use HTTPS and Secure Sockets Layer (SSL) certificates automatically. Verify that the Certificate Authority certificate is available to the trust store for the browser and Java clients. For more information, see the instructions.html file in the directory \SASConfigDir\Lev1\Documents, and the Chapter 5, “Setting Up Certificates for SAS Deployment,” in *SAS Intelligence Platform: Installation and Configuration Guide*. If you did not use the SAS Deployment Wizard to configure the SAS Web Server to use HTTPS and SSL certificates, you can configure it manually. For more information, see “Configuring SAS Web Server Manually for HTTPS” in Chapter 17 of *SAS Intelligence Platform: Middle-Tier Administration Guide*.

The communication path between SAS Web Server and SAS Web Application Server uses HTTP by default. If you configured the SAS Web Server to use HTTPS using the SAS Deployment Wizard, additional steps are required in order to use HTTPS between SAS Web Server and SAS Web Application Server. For more information, see “Configuring SAS Web Application Server to Use HTTPS” in Chapter 17 of *SAS Intelligence Platform: Middle-Tier Administration Guide*.

8. Configure SAS Workflow. For more information, see “Configuring SAS Workflow for Use with SAS Model Manager” on page 22.

9. Verify the configuration of the dashboard reports directory on the SAS Workspace Server. For more information, see “Configuring the Dashboard Reports Directory” on page 13.

10. Configure the Model Manager Java Services Options. For more information, see “Configuring Model Manager Java Services Options” on page 15.

11. If you have installed SAS Model Manager to use with SAS Enterprise Miner, you must access the SAS Content Server and create a public directory for SAS Enterprise Miner to register a model SAS package (SPK) file.

To create a SAS Content Server public directory:

a. Access the SAS Content Server Administration Console by entering http://hostname:port/SASContentServer/dircontents.jsp. An example of hostname:port is localhost:80. Log on using the SAS Administrator account (for example, sasadm@saspw) that you defined during the SAS installation process.

*Note:* The default port for the SAS Web Server in a UNIX environment is 7980.

b. In the Add folder field, enter a folder name such as Models.

c. Click Add folder.

d. The Models folder is displayed in the Item name column.

e. Click the Permissions icon that is associated with the Models folder.
f. In the **Add principal** field, enter the value `jcr:all`. Change all of the permissions to **Yes**.

g. Click **Save Changes**.

h. Log off from the SAS Content Server Administration Console and restart any open SAS Enterprise Miner sessions to pick up the changes.

12. If you have installed SAS Model Manager to use with SAS Enterprise Miner, you must configure the SAS Metadata Repository to use the SAS Content Server public directory that you created previously.

To configure the SAS Metadata Repository to use the SAS Content Server public directory:

a. In SAS Management Console, expand **Application Management** on the **Plugins** tab. SAS Enterprise Miner should be listed and should contain subfolders.

b. Expand the **Projects** folder.

c. Right-click the SAS Workspace Server that is associated with your SAS Enterprise Miner installation, and select **Properties**. An example is **SASApp - Logical Workspace Server**.

d. Click the **Options** tab.

e. In the **WebDAV URL** field, enter `http://hostname:port/SASContentServer/repository/default/Models/`.

   **Note:** WebDAV is used to register a model SPK file from SAS Enterprise Miner.

f. Click **OK** and then restart any open SAS Enterprise Miner sessions to pick up the changes.

For more information about post-installation tasks, see the SAS 9.4 installation documentation.

---

**Creating Operating System Accounts in UNIX Environments**

**Using Operating System Groups to Assign Permissions**

Users have different operating system privileges on the SAS Workspace Server. By defining a user group for SAS Model Manager, you can assign all SAS Model Manager users to the same group and grant the same permissions to all SAS Model Manager users at one time. All SAS Model Manager users must have Read, Write, and Execute permissions for each environment directory that a user is permitted to use. Users also need permissions to all of the files and directories in an environment directory. The operating system must be configured to grant these permissions as new files and directories are created. The steps that you follow to do this depend on which operating system groups are defined and your site’s security policies.
Conditions for the User Group for SAS Model Manager

If you are working in a UNIX operating environment, the following conditions must be met:

- A group of users is created for the UNIX operating environment. The logon IDs for each SAS Model Manager user must be in this group. The group must also include any user who might run code that is created from a SAS Model Manager project in a SAS session.

- Users can be members of multiple groups, but the SAS Model Manager group is the primary group for each user.

- The SAS scripts are updated to grant permissions to the SAS Model Manager users on the SAS Workspace Server. For more information, see “Update the SAS Scripts to Grant Permissions to the User Group” on page 11.

- Each environment directory has the correct ownership, and the user group for the SAS Model Manager has Read, Write, and Execute permissions.

Update the SAS Scripts to Grant Permissions to the User Group

Using the umask option, you can grant permissions to the SAS Model Manager users on a conditional basis if the user is part of the SAS Model Manager user group.

Note: This example might require changes to fit your server configuration. In particular, this example could result in changed permissions on other SAS files, such as OLAP cubes. For example, if you are working with multiple UNIX groups and have a SAS OLAP Server, you must ensure that the account under which the SAS OLAP Server runs keeps the Read and Execute permissions to OLAP files.

To set these permissions:


2. Enter the configuration information for your operating environment. Here is the general format of this code:

   ```
   CMD=<your-operating-system-path>
   CURR_GID=`eval $CMD -g`
   GID=<solution-group-id>
   if [ $CURR_GID -eq $GID ]; then umask 002 fi
   ```

   a In the CMD=<your-operating-system-path>, specify the full path on your server where the ID command is stored. You can get this information by entering a which id or whence id command on your console.

   b In the GID=<solution-group-id>, specify the group ID. Type id on your console to get the GID and UID information.

   c A value of 002 is recommended for the umask option.

Here are code examples for each UNIX environment where SAS Model Manager is supported:
<table>
<thead>
<tr>
<th>Operating Environment</th>
<th>Sample Code</th>
</tr>
</thead>
</table>
| AIX                   | CMD="/usr/bin/id  
CURR_GID='eval $CMD -g'  
GID=201
if [ $CURR_GID -eq $GID ]; then umask 002 fi |
| H64I (HP-Itanium)     | CMD="/usr/bin/id  
CURR_GID='eval $CMD -g'  
GID=201 if [ $CURR_GID -eq "$GID" ]; then umask 002 fi |
| S64 (Solaris)         | CMD="/usr/xpg4/bin/id  
CURR_GID='eval $CMD -g'  
GID=201 if [ $CURR_GID -eq $GID ]; then umask 002 fi |
| SAX (Solaris for X64) | CMD="/usr/xpg4/bin/id  
CURR_GID='eval $CMD -g'  
GID=201  
if [ $CURR_GID -eq $GID ]; then umask 002 fi |
| LNX (Linux)           | #!/bin/bash  
CMD="/usr/bin/id  
CURR_GID='eval $CMD -g'  
GID=500
if [ "$CURR_GID" -eq "$GID" ]; then umask 002 fi |

## Configuring a SAS Application Server

SAS Model Manager 12.3 on SAS 9.4 provides support for multiple SAS Application Servers that can be used when defining a performance task, a scoring task, or a model retrain task.

To add a new SAS Application Server:

1. From SAS Management Console, expand the Application Management node on the Plug-ins tab.
2. Right-click Server Manager and select New Server.
4. Enter the name and the description of your SAS Application Server. Click Next.
5. Accept the default values for the server properties and click Next.
7. Enter the full server name for the Host Name and click Next.
8. Click Finish.
9. Right-click **Object Spawner** and select **Properties**. Click the **Servers** tab, and then click the right-arrow to move the new server to the selected servers. Click **OK**.

10. To make the new server available to the JobExecutionService:

    a. Expand **Application Management** ⇒ **Configuration Manager** ⇒ **SAS Application Infrastructure** ⇒ **Web Infra Platform Services 9.4**.
    
    b. Right-click **JobExecutionService**, and then select **Properties**.
    
    c. Select the **Settings** tab and move the new server from the **Available** servers list to the **Selected** servers list.
    
    d. Clear the check box for the **Enable for Interactive execution?** setting.
    
    e. Click **OK**.

11. Restart the SAS servers and the web application server.

For more information, see Chapter 10, “Managing SAS Application Servers,” in *SAS Intelligence Platform: Application Server Administration Guide*.

---

**Enabling the SAS Workspace Server XCMD Option**

When you are running the SAS Workspace Server in a UNIX environment for a SAS Model Manager 12.3 on SAS 9.4 deployment, the XCMD option is turned off by default. So you cannot use the SYSTEM function, the X command, or the PIPE option in a FILENAME statement. You must enable the SAS Workspace Server XCMD option in order to support R model functionality.

To enable the XCMD option:

1. From SAS Management Console, expand the **Server Manager** node on the **Plug-ins** tab.

2. Select and expand **SASApp** ⇒ **SASApp – Logical Workspace Server**.

3. Right-click **SASApp - Workspace Server** and select **Properties**.

4. Select **Options** ⇒ **Advanced Options** ⇒ **Launch Properties** and then select the **Allow XCMD** check box.

5. Click **OK** to save the setting.

6. (Optional) If you have multiple SAS Application Servers with the server type of Workspace Server, repeat steps 2 through 5.

7. Stop and restart your SAS Object Spawner.

---

**Configuring the Dashboard Reports Directory**

In SAS Model Manager 12.3, the dashboard report directory is configured during installation. The default directory is `C\SASConfigDir\Lev#\AppData\SASModelManager12.3\Dashboard`.
Note: When the Application Server and the SAS Workspace Server are located on different physical machines, the Software Deployment Wizard creates a directory on the Application Server machine and uses that value for the `App.DashboardDir` property value. You must create a directory that is accessible by the SAS Workspace server, and the SAS Model Manager users must have permissions to the directory.

To configure a different directory to store the SAS Model Manager dashboard reports, follow these steps:

1. Connect to the SAS Workspace Server.
2. Create a new directory (for example, `C:\Dashboard`).
   
   Note: The directory must be located on a SAS Workspace Server or a network drive that is accessible by the SAS Workspace Server. Do not include special characters or spaces in the name of the directory.

3. Grant user permissions for the new directory. For example, perform the following tasks:
   
   • Grant Full Control permission to users who need to create subdirectories, write content, or delete content. This type of user includes a user who you will be adding (using SAS Management Console) to the Model Manager Administrator Users group or a user who is a SAS Administrator.
   
   • Grant Read, Write, and Execute permissions to users who need to create performance indicators and execute dashboard reports. This type of user includes a user who you will be adding (using SAS Management Console) to the Model Manager Advanced Users group.
   
   • Grant Read and Execute permissions to users who need only to view the dashboard reports. This type of user includes a user who you will add (using SAS Management Console) to the Model Manager Users group.
   
   Note: In a UNIX environment all SAS Model Manager users must be part of a group that has the appropriate group permissions. For more information, see “Creating Operating System Accounts in UNIX Environments” on page 10 and “Configuring Users, Groups, and Roles” on page 34.

4. From SAS Management Console, expand the **Application Management** node on the **Plug-ins** tab.

5. Select and expand **Configuration Manager** ➔ **SAS Application Infrastructure**.

6. Right-click **Model Manager JavaSvcs 12.3** and select **Properties**.

7. (optional) Click the **Settings** tab and then select **Report Options**. Use this setting to specify the styles that are available when a user generates dashboard reports, and to enable the indicator override option for defining dashboard report indicators. When you use the indicator override configuration, indicators with conditions are available when you add dashboard report indicators using the SAS Model Manager Client. For more information, see “Report Options” on page 16.

8. Click the **Advanced** tab to modify the application dashboard directory. Change the property value for `App.DashboardDir` to the directory path that was configured.

9. Click **OK**.

10. For changes to take effect, you must restart the web application server.
Configuring Model Manager Java Services Options

Overview of Configuring Model Manager Java Services Options

The Model Manager Java Services Options in SAS Management Console enables you to modify SAS Model Manager configurations. The configurations can be modified for reporting, metadata tables usage when publishing a scoring function, SAS code debugging, SAS system options, In-database connection and publishing options, and performance options for the High-Performance Analytics procedure.

To modify the settings for the report options:

1. Log on to SAS Management Console as a SAS administrator.
2. On the Plug-ins tab, navigate to Application Management ⇒ Configuration Manager ⇒ SAS Application Infrastructure.
3. Right-click Model Manager JavaSvcs 12.3 and select Properties.
4. Click the Settings tab and then select Model Manager Java Services.

5. Select one of the following options to view and configure the available settings.
   - Report Options
   - Publish Scoring Options
   - Debug Options
   - Valid Variable Name Options
   - In–Database Options
   - Performance Options
6. Click **OK**.

7. For changes to take effect, you must restart the web application server.

---

**Report Options**

The **Report Options** setting in SAS Management Console enables you to modify the SAS Model Manager configurations for the dashboard reports, model retrain reports, and performance monitoring. These reports are available when you use the SAS Model Manager client.

To modify the report options setting:

1. Specify the formats that are available when a user creates model retrain reports. The default values are RTF, PDF, HTML, and EXCEL. You can remove any of the default values so that they are not available in the SAS Model Manager client.

2. Specify the report styles that are available when a user creates the model retrain reports and dashboard reports. You can add or remove SAS styles. The default values are SAS default, Seaside, Meadow, and Harvest. For more information about SAS styles, see “Understanding Styles, Style Elements, and Style Attributes” in Chapter 3 of *SAS Output Delivery System: User’s Guide*.

3. Select **Yes** for the dashboard indicator override. When you do that, indicators with conditions are available when a user adds dashboard report indicators.

4. Specify a value for random seed to be used by performance tasks for models that have an interval target. The default value is **12345**. The **random seed** is the initial seed for the random number generator used for sampling the input data set.

5. Specify a value for the sample size that is used by performance tasks for models that have an interval target. The default value is **1000**. The **sample size for models with an interval target** is the number of observations from the input data set.

6. Specify a value for the sample size that is used by performance tasks for characteristic and stability analysis. The default value is **10000**. The **sample size for characteristic and stability analysis** is the number of observations from the input data set.

7. Select **Yes** or **No** to specify whether to use the temporary tables on the High-Performance Analytics appliance for performance monitoring. The default is **Yes**.

8. Specify a value for the correlation coefficient (rho) that is used by the binomial test to estimate the probability of default (PD) levels. The default value is **0.04**.

---

**Publish Scoring Options**

The **Publish Scoring Options** setting enables you to indicate that the metadata tables be populated in the target database when publishing a scoring function. The default is **Yes**. During the installation and configuration process of the database, the metadata tables must be created in the database if this setting is set to **Yes**. If you plan on only using the SAS Embedded Process publish method to publish scoring model files, this setting can be ignored, and you do not need to create the metadata tables during the database configuration process.

For information about the database configurations, see “**Configure the SAS Model Manager Database**” on page 5. For more information about publishing models to a
database, see “Publishing Models to a Database” in Chapter 13 of SAS Model Manager: User’s Guide.

**Debug Options**

The **Debug Options** setting enables you to use the debug options when executing SAS code within the SAS Model Manager client. The default value is **No**.

The **Debug Options** setting does not work for scoring tasks, performance tasks, and model retrain tasks. To enable debug options with scoring tasks, you must add the following line of code to the *sasv9_usermods.sas* file in the `\sasconfigdir\Lev\SASApp\WorkspaceServer\` directory:

```sas
options mprint symbolgen notes;
```

**Valid Variable Name Options**

The **Valid Variable Name Options** setting enables you to set the VALIDVARNAME system option to ANY when executing SAS code. The default value is **No**.

The **Valid Variable Name Options** setting does not work for scoring tasks. To use the VALIDVARNAME system option with scoring tasks, you must add the following line of code to the *sasv9_usermods.sas* file in the `\sasconfigdir\Lev\SASApp\WorkspaceServer\` directory:

```sas
options validvarname='any';
```

**In-Database Options**

The **In-Database Options** settings enables you to specify the publish type, database connection settings, and publish settings that are used when publishing models to a database using SAS Model Manager.

To modify the settings for the in–database options:

1. Select a method to publish models to the database for scoring. The default publish type is the **SAS Embedded Process** publish method.
2. Select a database type.
3. Specify values for database settings that are required to publish to the selected database type.

Here are the available database settings according to the publish method and database type:

<table>
<thead>
<tr>
<th>Database Settings</th>
<th>SAS Embedded Process</th>
<th>Scoring Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server name</strong></td>
<td>• Teradata</td>
<td>• Teradata</td>
</tr>
<tr>
<td></td>
<td>• Oracle</td>
<td>• Netezza</td>
</tr>
<tr>
<td></td>
<td>• Netezza</td>
<td>• Greenplum</td>
</tr>
<tr>
<td></td>
<td>• Greenplum</td>
<td>• DB2</td>
</tr>
<tr>
<td></td>
<td>• DB2</td>
<td></td>
</tr>
</tbody>
</table>
### Database Settings

<table>
<thead>
<tr>
<th>Database name</th>
<th>SAS Embedded Process</th>
<th>Scoring Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Teradata</td>
<td>• Teradata</td>
<td></td>
</tr>
<tr>
<td>• Oracle</td>
<td>• Netezza</td>
<td></td>
</tr>
<tr>
<td>• Netezza</td>
<td>• Greenplum</td>
<td></td>
</tr>
<tr>
<td>• Greenplum</td>
<td>• DB2</td>
<td></td>
</tr>
<tr>
<td>• DB2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User ID</th>
<th>SAS Embedded Process</th>
<th>Scoring Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Teradata</td>
<td>• Teradata</td>
<td></td>
</tr>
<tr>
<td>• Oracle</td>
<td>• Netezza</td>
<td></td>
</tr>
<tr>
<td>• Netezza</td>
<td>• Greenplum</td>
<td></td>
</tr>
<tr>
<td>• Greenplum</td>
<td>• DB2</td>
<td></td>
</tr>
<tr>
<td>• DB2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Server user ID</th>
<th>SAS Embedded Process</th>
<th>Scoring Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not applicable</td>
<td>DB2</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Schema</th>
<th>SAS Embedded Process</th>
<th>Scoring Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Oracle</td>
<td></td>
<td>Greenplum</td>
</tr>
<tr>
<td>• Greenplum</td>
<td></td>
<td>DB2</td>
</tr>
<tr>
<td>• DB2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4. Specify to use the model manager table when publishing. The default value is **No**. When you are publishing the scoring model files to a database using the SAS Embedded Process publish method, the files are by default stored in the table sas_model_table. If the **use model manager table** value is set to **Yes**, the scoring model files are stored in the table sas_mdlmgr_ep. These tables are located in the target database. This setting provides the ability for users to separate the SAS Model Manager scoring model files from the SAS model scoring files when using the SAS Embedded Process publish method.

5. Specify to force the republish of model scoring files by default when using the SAS Embedded Process publish type. The default value is **No**. If you set this setting to **Yes**, then the **Replace scoring files that have the same publish name** option in the Publish Models to a Database window in SAS Model Manager is selected by default.

6. Select the default format of the model publish name when using the SAS Embedded Process publish method. The format selected determines the value that appears for the publish name in the Publish Models to a Database window in SAS Model Manager. The scoring function publish method publish name defaults to the model name.

7. Specify a directory path to store the temporary scoring files. If a value is not specified, the SAS work directory is used by default. However, if you select the **Display detailed log messages** option when publishing to a database, the SASUSER directory is used.

**Note:** The **Support Netezza SAS Embedded Process** setting is set to **No** by default. The SAS Embedded Process can be used with the SAS Scoring Accelerator for Netezza to run scoring models with the release of SAS 9.4. This setting enables you to turn on the support for SAS Model Manager, so that the Netezza database type appears in the database type drop-down list in SAS Model Manage when using the SAS Embedded Process publish method.
For information about the database configurations, see “Configure the SAS Model Manager Database” on page 5. For more information about publishing models to a database, see “Publishing Models to a Database” in Chapter 13 of SAS Model Manager: User's Guide.

Performance Options

The performance options contains the performance parameters for the PERFORMANCE statement to use the High-Performance Analytics procedure. Currently only the Teradata and Greenplum database types support High-Performance Analytics.

The PERFORMANCE statement defines performance parameters for multithreaded and distributed computing, passes variables about the distributed computing environment, and requests detailed results about the performance characteristics of a High-Performance Analytics procedure.

The following performance options can be specified for the PERFORMANCE statement.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commit</td>
<td>Specifies an integer to request that the High-Performance Analytics procedure writes periodic updates to the SAS log.</td>
<td>10000</td>
</tr>
<tr>
<td>CPU count</td>
<td>Specifies how many processors that the procedure should assume are available on each host in the computing environment. You can enter the value of ACTUAL, or enter an integer between 1 and 256.</td>
<td>ACTUAL</td>
</tr>
<tr>
<td>Database server</td>
<td>Specifies the name of the server for the database as defined through the hosts file and as used in the LIBNAME statement.</td>
<td></td>
</tr>
<tr>
<td>Details</td>
<td>Requests a table that shows a timing breakdown of the procedure steps.</td>
<td>No</td>
</tr>
<tr>
<td>Timeout</td>
<td>Specifies the timeout in seconds for a High-Performance Analytics procedure to wait for a connection to the appliance and establish a connection back to the client.</td>
<td>120</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Default Value</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Host name</td>
<td>Specifies the name of the appliance. If a value for the Host option is specified, it overrides the value of the grid host environment variable.</td>
<td></td>
</tr>
<tr>
<td>Installation directory</td>
<td>Specify the name of the directory in which the High-Performance Analytics shared libraries are installed on the appliance.</td>
<td></td>
</tr>
<tr>
<td>Install location</td>
<td>Specify the name of the directory in which the High-Performance Analytics shared libraries are installed on the appliance. If a value is specified for the Installation directory option, it overrides this option.</td>
<td></td>
</tr>
<tr>
<td>Number of nodes</td>
<td>Specifies the number of nodes in the distributed computing environment, provided that the data is not processed alongside the database. You can enter an integer or you can specify a value of ALL if you want to use all available nodes on the appliance without oversubscribing the system.</td>
<td></td>
</tr>
<tr>
<td>Number of threads</td>
<td>Specify the number of threads for analytic computations. This option overrides the SAS system option THREADS</td>
<td>NOTHREADS. If you do not specify a value for this option, the number of threads are determined based on the number of CPUs on the host on which the analytic computations execute.</td>
</tr>
<tr>
<td>Grid host</td>
<td>Specifies the host name for the grid. If a value for the Host option is specified, it overrides the value of the grid host environment variable.</td>
<td></td>
</tr>
<tr>
<td>Grid RSH command</td>
<td>Specifies the command to run a remote shell.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Default Value</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Grid reply host</td>
<td>The host name of the client node to which the grid connects.</td>
<td></td>
</tr>
<tr>
<td>Grid port range</td>
<td>Specifies the range of parts that are permitted by the firewall.</td>
<td></td>
</tr>
<tr>
<td>Grid path</td>
<td>Specifies the local directory path for the grid node.</td>
<td></td>
</tr>
<tr>
<td>Grid mode</td>
<td>specifies whether the HPFORECAST procedure runs in symmetric (SYM) mode or asymmetric (ASYM) mode. The default is symmetric (GRIDMODE=SYM).</td>
<td>Symmetric</td>
</tr>
</tbody>
</table>

For more information about High-Performance Analytics, see the *SAS High-Performance Analytics Server: User's Guide*.

---

### Configuring and Using Java Web Start

For a SAS Model Manager 12.3 on SAS 9.4 deployment, the Java Web Start client can be used to access the SAS Model Manager 12.3 application by entering the URL `http://hostname:port/SASModelManagerJWS/Status` in your web browser. The default value for the SAS Environments URL on the Status page is `undefined`. When you click **Launch**, the default value for the SAS environment field is *(host deployment)*, unless you configure the Java Web Start Client to use the SAS environment URL in SAS Management Console.

**Note:** Only a SAS administrator (for example, sasadmsaspw) can configure the Java Web Start client for SAS Model Manager.

To specify the link to the Java Web Start client as the SAS environment URL, follow these steps:

1. From SAS Management Console, expand the **Application Management** node on the **Plug-ins** tab.
2. Select and expand **Configuration Manager** ➝ **SAS Application Infrastructure**.
3. Right-click **Model Manager JWS 12.3** and select **Properties**.
4. Click the **Settings** tab, and then select **Model Manager Java Web Start Options**.
   - Enter a value is for the **SAS environment URL** setting, and in the format of `http://hostname:port/SAS/sas-environment.xml`. For more information about SAS environments, see “Configuring the SAS Environment File” in Chapter 1 of the *SAS Intelligence Platform: Middle-Tier Administration Guide*. 
1. Verify that the value that is specified for the **Preferred SAS environment** setting is the SAS environment that should be selected by default in the client’s logon dialog box. If a valid SAS environment with the specified name is not found, the value is ignored.

5. Make any necessary changes to the settings, and click **OK**.

6. For changes to take effect, you must restart the web application server.

7. To verify that Java Web Start has been configured correctly, enter the URL `http://hostname:port/SASModelManagerJWS/Status` in your web browser, verify that there is a value for the **SAS Environments URL** property, and then click **Launch**.

---

### Configuring the Limitation on the Number of Observations for a Scoring Result Set

When the **Scoring Task Type** property is set to **Production** in SAS Model Manager, you can use SAS Management Console to limit the number of observations that a scoring result set can contain.

To configure a limitation for the number of observations:

1. From SAS Management Console, expand the **Application Management** node on the **Plug-ins** tab.

2. Select and expand **Configuration Manager => SAS Application Infrastructure**.

3. Right-click **Model Manager JavaSvcs 12.3** and select **Properties**.

4. Click the **Advanced** tab. Change the property value for **App.TableObsLimitation** to limit the number of observations in the scoring result set. The default value of 0 indicates that there is no limit to the number of observations that a scoring result set can contain.

5. Click **OK**. The value that you specified now appears in the Number of Observations result set property when you create a scoring task using SAS Model Manager.

---

### Configuring SAS Workflow for Use with SAS Model Manager

**Overview**

SAS Workflow provides services that work together to model, automate, integrate, and streamline business processes. It provides a platform for more efficient and productive business solutions.

SAS Workflow is used by SAS solutions that benefit from business process management. SAS Workflow Studio is a desktop client application that is used to design and deploy workflow definitions. The SAS middle tier hosts the workflow engine and the workflow services as part of the SAS Web Infrastructure Platform. The SAS Model Manager Workflow Console is used to manage the workflows that are associated with
versions in a modeling project. For more information about SAS Workflow, see “SAS Workflow” in Chapter 1 of *SAS Intelligence Platform: Middle-Tier Administration Guide*.

To use SAS Workflow with SAS Model Manager, be sure the following prerequisites are met:

1. SAS Workflow Engine, SAS Workflow Services, and SAS Workflow Studio must be installed and configured. For more information, see *SAS Intelligence Platform: Installation and Configuration Guide*.

2. If you want to receive notifications for a workflow, you can configure alert notifications using SAS Management Console. For more information, see “Configuring Alert Notifications for SAS Workflow” on page 43.

3. Workflow definitions must be created using SAS Workflow Studio. For more information about creating workflow definitions, see the *SAS Workflow Studio: User's Guide*.

**Guidelines for Creating Workflow Definitions**

When you create workflow definitions in SAS Workflow Studio to use with SAS Model Manager, follow these guidelines:

- Participants, and policies must be added to the task level. Statuses added at the task level and the default statuses at the workflow definition level can be used for a task status. Data objects can be added at the workflow definition level or task level.

  *Note:* The tasks that are defined in SAS Workflow Studio as part of a workflow definition are displayed as activities in the SAS Model Manager Workflow Console.

- Only the Potential Owner and Business Administrator workflow roles are used by SAS Model Manager and they can be used in either a participant or swimlane definition.

- In order to assign additional participants to activities using the Workflow Console, the user must have or be in a group that is assigned the workflow role of business administrator. Also, in order to create new workflows and assign participants, the user must be in the Model Manager Administrator Users group or in a group that is associated with the Model Manager Administrator Users group in SAS Management Console.

The *Create a workflow instance* capability must be enabled for the usage role that is associated with a user or group in order for them to be able to create workflows. By default this capability is enabled for the Model Manager: Administration Usage role that is associated with the Model Manager Administrator Users group. You can access the capability from the **Capabilities** tab in the Role Properties window. In the assigned capabilities tree, expand **Model Manager JavaSvcs 12.3 ⇨ Workflow Service**.

The following SAS Model Manager groups are created at installation time:

- Model Manager Administrator Users Group (mdlmgradminusers)
- Model Manager Advanced Users Group (mdlmgradvusers)

For more information, see “Configuring Users, Groups, and Roles” on page 34.
Only workflow definitions that are in the Workflow repository, with the `mmapi` tag attribute specified in the file properties, are available to SAS Model Manager in the Workflow Console.

**How to Associate a Model Management Component with a Workflow Activity**

You can associate a model management component with an activity (or task) as part of creating a workflow definition. First you must create a workflow definition using SAS Workflow Studio. Add the tasks, statuses, and data objects that you want to include in your workflow. For more information about creating a workflow definition, see the *SAS Workflow Studio: User's Guide*.

To associate a model management component with an activity:

1. Start SAS Workflow Studio, and then open a workflow definition.
2. Expand the **Tasks** node in the workflow tree.
3. Expand a task node, right-click the **Data Objects** folder, and select the **New Data Object** menu option.
4. Enter `MM_TaskToDo` for the data object label.
5. Select **Short Text** from for the type of data object.
6. Enter the model management component directory path and XML filename in the **Text** property. The directory path is `ConfigTemplates/nodeTemplates/<XML-filename>`. See Table 3.1 on page 25 to get the appropriate XML filename.
7. Click **OK**.

8. Repeat steps 3 through 7 for each task that you want to associate a model management component.

### Table 3.1 List of Model Management Components

<table>
<thead>
<tr>
<th>Model Management Component Name</th>
<th>Description</th>
<th>XML Filename</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Documents</td>
<td>This component enables you to attach documents to the <strong>Documents</strong> folder at the project, or version level.</td>
<td>AddDocument.xml</td>
</tr>
<tr>
<td>Import Models</td>
<td>This component enables you to import models from the SAS Metadata Repository, a SAS package file (.spk), or a PMML file (.xml) into the version that is associated with the workflow.</td>
<td>ModelRegistration.xml</td>
</tr>
<tr>
<td>Publish Models</td>
<td>This component enables you to publish champion and challenger models from the model repository to the SAS Metadata Repository or to a database.</td>
<td>ModelPublish.xml</td>
</tr>
<tr>
<td>Set Champion and Challenger</td>
<td>This component enables you to set a project champion model and challenger models.</td>
<td>SetChampionOrChallenger.xml</td>
</tr>
<tr>
<td>Model Management Component Name</td>
<td>Description</td>
<td>XML Filename</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>View Models</td>
<td>This component enables you to view a list of the models. You can also view model information such as properties, model variables, score code, model files, notes, and history. By default, the Model Viewer component is available from both the Import Models and also the Set Champion and Challenger components.</td>
<td>GenericModelViewer.xml</td>
</tr>
<tr>
<td>View Model Performance</td>
<td>This component enables you to view the performance of the project champion model through a series of charts. The performance charts are generated using performance tasks in the SAS Model Manager client application.</td>
<td>PerformanceView.xml</td>
</tr>
<tr>
<td>View Reports</td>
<td>This component enables you to view reports that have been created using the Workflow Console or by using the New Report wizard under the associated version in the SAS Model Manager client application.</td>
<td>ReportsView.xml</td>
</tr>
<tr>
<td>Create and View Reports</td>
<td>This component enables you to create and view reports. Reports that were created using the New Report wizard under the associated version in the SAS Model Manager client application are displayed as well.</td>
<td>ReportsViewAndCreation.xml</td>
</tr>
<tr>
<td>Utility</td>
<td>This component consists of all of the available model management components.</td>
<td>Utility.xml</td>
</tr>
</tbody>
</table>

**Note:** The list of the model management components that can be configured to be used with the SAS Model Manager Workflow Console can also be found at [http://server-name:port/SASContentServer/repository/default/ModelManager/ConfigTemplates/nodeTemplates/](http://server-name:port/SASContentServer/repository/default/ModelManager/ConfigTemplates/nodeTemplates/)

**How to Associate a Milestone with a Workflow Activity**

You can specify the process type of milestone for a workflow definition and associate a milestone ID with an activity (or task) as part of creating a workflow definition. This
enables the workflow and tasks that are associated with a version to appear on the Workflow Milestones tab in the version details view, and in the Workflow Milestones Report in SAS Model Manager.

First you must create a workflow definition using SAS Workflow Studio. Add the tasks, statuses, and data objects that you want to include in your workflow. For more information about creating a workflow definition, see the SAS Workflow Studio: User's Guide.

To specify the process type of milestone for a workflow definition, you must add a data object for the process type at the workflow definition level. To add the Process Type data object at the workflow definition level:

1. Start SAS Workflow Studio, and then open a workflow definition.
2. Right-click the Data Objects folder, and select the New Data Object menu option.
3. Enter Process Type for the data object label.
4. Select Short Text from for the type of data object.
5. Enter Milestone in the Text property.
6. Click OK.

To associate a milestone ID with a task:
1. Start SAS Workflow Studio, and then open a workflow definition.
2. Expand the Tasks node in the workflow tree.
3. Expand a task node, right-click the Data Objects folder, and select the New Data Object menu option.

![New Data Object dialog box]

4. Enter MM_MilestoneID for the data object label.
5. Select Short Text from for the type of data object.
6. Enter a name for the milestone ID in the Text property. The name can be the same as the task name.

![New Data Object dialog box with MM_MilestoneID entered]

7. Click OK.
8. Repeat steps 3 through 7 for each task that you want to associate a milestone ID so that it appears on the Workflow Milestones report.

---

**How to Make Workflow Definitions Available to SAS Model Manager**

After you have created a workflow definition in the SAS Workflow Studio, you must make the workflow definition available to SAS Model Manager.

To save the workflow definition to the Workflow repository:

1. Save the workflow definition to your local drive.
2. Log on to the server.
3. Add the tag attribute of mmapi to the workflow definition file properties.
4. Upload the workflow definition.
5. Verify that the workflow definition appears in the Workflow Definitions category view of SAS Model Manager Workflow Console.

For more information, see “Deploying and Maintaining Workflows” in Chapter 5 of SAS Workflow Studio: User’s Guide.

Log On to the Server

With SAS Workflow Studio, you are limited to managing locally stored workflow definitions on your system until you have logged on to the SAS Content Server. After you are connected, you can access additional workflow definitions that are stored in the SAS Content Server.

To log on to the server:
1. From the Server menu, select Log On.
2. In the Log On window, select the host-name from the SAS environment drop-down list.
   Note: For more information, see “Configuring the SAS Environment File” in Chapter 1 of SAS Intelligence Platform: Middle-Tier Administration Guide.
3. Enter a user ID and password, and click Log On.
4. Click OK for success message that might appear.

Add Tag Attributes to a Workflow Definition

Only those workflow definitions in the Workflow repository that have the mmapi tag attribute specified in the file properties are available to SAS Model Manager in the Workflow Console.

To add a tag attribute to the file properties of a workflow template in SAS Workflow Studio:
1. Select File ➔ Properties and click Add.
2. Enter the tag value of mmapi.
   Note: The file properties are case sensitive. This value must be lowercase.
3. Click OK twice.

Upload a Workflow Definition

To upload a workflow:
1. From the Server menu, select the Save to Repository menu option. The Save to Workflow Repository window appears.
2. (Optional) Enter relevant comments to associate with the workflow definition.
3. Select the Activate option if you want to activate the current version in the Workflow repository.
4. Click OK.
5. Click OK for the success messages that might appear.
Verify That the Workflow Definitions Are Available in the Workflow Console

To verify that the workflow definitions are available in the Workflow Console:

1. Enter the URL http://hostname:port/SASModelManagerWorkflow in your web browser.

2. Enter the user ID and password for a SAS Model Manager administrator.

3. Verify that the uploaded workflow definition appears in the Workflow Definitions category view.

See Also

Chapter 4
Setting Up SAS Management Console for Use

Overview of Setting Up SAS Management Console for Use with SAS Model Manager

SAS Management Console acts as the user interface to the SAS Metadata Repository. In order for SAS Model Manager to read data tables, the metadata for those tables must also exist within the SAS Metadata Repository. The metadata for the data tables is stored in libraries within the SAS Metadata Repository. SAS Management Console also enables administrators to configure users, groups, roles and to create publication channels.

You can determine how you want to organize your SAS libraries. For example, you can put all of the tables that are needed by a given project, version, model, scoring task, and report in one library. Or, you can create seven libraries that correspond to the structure of the Data Sources folders that SAS Model Manager uses. In most cases, users already
have model tables grouped in project-related SAS libraries. Most of the time, your SAS Model Manager Data Sources folders contain tables from different SAS libraries.

## Configuring a SAS Model Manager Connection Profile for the SAS Metadata Repository

### Overview of Configuring a Connection Profile

A connection profile enables you to communicate with the SAS Metadata Repository from SAS Management Console. Before you can define SAS Model Manager libraries, users, groups, roles, and publication channels in SAS Management Console, you must create a connection profile.

The Connection Profile wizard guides you through the process of creating the profile for your server. For more information, see the Help.

### Create a New Connection Profile

To create a new connection profile:

1. Start SAS Management Console. The **Connection Profile** dialog box appears.

2. Select **Create a new connection profile**, and click **OK**. The Connection Profile wizard window appears.
3. Click Next.

4. Enter the name of your connection profile. Select the check box if you want to open this connection profile by default. Click Next.

5. Complete the following connection information:
   a. Enter the fully qualified name (or IP address) of the machine on which your metadata server operates. Enter the TCP/IP port number that was defined at installation. By default the port is 8561.
   b. Enter a valid user ID and a password.
   c. (Optional) Select the check box to save the user ID and password for this profile.
      *Note:* When you select this option, the user ID and password are saved and automatically displayed when this profile is chosen during login.
   d. Click Next. A summary of the connection profile options that you defined is displayed.

6. Click Finish to save your connection profile.

   SAS Management Console is then connected to your active connection profile server as shown on the window title bar.

   *Note:* You need to verify that Publishing Framework plug-ins are available on your SAS Management Console navigation tree. Otherwise, you need to install SAS Foundation Services so that you can configure your channels and subscribers for SAS Model Manager.

**Connect to an Existing Connection Profile**

To connect to or change your SAS Metadata Server connection profile:

1. Select File ⇒ Connection Profile. The Disconnect from Server dialog box appears.
2. Click Yes. The Connection Profile dialog box appears.

3. Select **Open an existing connection profile**.

4. Select the name of your SAS Metadata Server connection profile from the list.

5. Click **OK**.

Now you should see your SAS Metadata Server name in the SAS Management Console status bar (server-name:port number).

---

**Configuring Users, Groups, and Roles**

**Overview of Configuring Users, Groups, and Roles**

When you use SAS Management Console to configure users, groups, and roles, users from different departments or divisions can collaborate to create, update, and deploy models. They use the SAS Publishing Framework to inform subscribers about model updates.

As an administrator, you need to create users, user groups, and then assign roles in order for users to access the SAS Model Manager repository. The **User Manager** plug-in for SAS Management Console allows a user to define a user or a group. A wizard helps you create the user and groups of users and also to assign roles.

*Note:* If you are using an automated approach to add and maintain user identities, see Appendix 2, “User Import Macros,” in *SAS Intelligence Platform: Security Administration Guide.*

**SAS Model Manager Users, Groups, and Roles**

The following users, groups, and roles are created as part of the SAS Model Manager installation process:
Note: The SAS Model Manager Administrator user is no longer created by default during installation. You must create a user and assign the user to the Model Manager Administrator Users group.

**Table 4.1  SAS Model Manager Users**

<table>
<thead>
<tr>
<th>User</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Administrator</td>
<td>This user has access to all SAS Management Console capabilities and metadata administrative tasks. SAS 9.4 creates this user during installation.</td>
</tr>
<tr>
<td>SAS Demo User</td>
<td>This user is optional. You can choose to create this user during installation. However, this user is not assigned to a group during installation.</td>
</tr>
</tbody>
</table>

**Table 4.2  SAS Model Manager Groups**

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Administrators</td>
<td>This group performs metadata administrative tasks. SAS 9.4 creates this group during installation.</td>
</tr>
<tr>
<td>Model Manager Administrator Users</td>
<td>This group has administrative permissions for the SAS Model Manager Client and to the Workflow Console.</td>
</tr>
<tr>
<td>Model Manager Advanced Users</td>
<td>This group has permissions to read, write, and delete content.</td>
</tr>
<tr>
<td>Model Manager Users</td>
<td>This group has permission to read content.</td>
</tr>
<tr>
<td>Model Manager Example Life Cycle Assignee Users</td>
<td>This group is used by the example life cycle templates that are shipped with SAS Model Manager. The group contains those users who can change the status of life cycle tasks, but who cannot approve them.</td>
</tr>
<tr>
<td>Model Manager Example Life Cycle Approver User</td>
<td>This group is used by the example life cycles templates that are shipped with SAS Model Manager. The group contains those users who can approve completed life cycle tasks.</td>
</tr>
</tbody>
</table>
Table 4.3  SAS Model Manager Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments Administrator</td>
<td>A user who can manage comments in the SAS Model Manager Workflow Console. This role is assigned to the group Model Manager Administrators.</td>
</tr>
<tr>
<td>Management Console: Advanced</td>
<td>Provides access to all plug-ins in SAS Management Console. This role is assigned to the group SAS Administrators.</td>
</tr>
<tr>
<td>Metadata Server: Operation</td>
<td>Supports adding metadata repositories and operating the metadata server. This role is assigned to the group SAS Administrators.</td>
</tr>
<tr>
<td>Metadata Server: User Administration</td>
<td>Supports management of users, groups, and roles other than the unrestricted users role. This role is assigned to the group SAS Administrators.</td>
</tr>
<tr>
<td>Metadata Server: Unrestricted</td>
<td>Provides all capabilities in SAS Management Console and provides access to all metadata. This role is assigned to the group SAS Administrator Users.</td>
</tr>
<tr>
<td>Model Manager: Administration Usage</td>
<td>A user who can perform all SAS Model Manager tasks. This role is assigned to the group Model Manager Administrator Users.</td>
</tr>
<tr>
<td>Model Manager: Advanced Usage</td>
<td>A user who can perform all SAS Model Manager tasks except for tasks that can be performed only by a SAS Model Manager administrator. This role is assigned to the group Model Manager Advanced Users.</td>
</tr>
<tr>
<td>Model Manager: Usage</td>
<td>A SAS Model Manager general user. The general user can perform all tasks except for advanced user tasks and administrator tasks. This role is assigned to the group Model Manager Users.</td>
</tr>
<tr>
<td>Model Manager: Life Cycle Assignee Usage</td>
<td>A user or group who can be assigned to complete a life cycle task.</td>
</tr>
<tr>
<td>Model Manager: Life Cycle Approval Usage</td>
<td>A user or group who can approve the completion of a life cycle task.</td>
</tr>
</tbody>
</table>
### Role

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Manager: Life Cycle Participant Usage</td>
<td>A user or group that is displayed in the Participant selection list of the Life Cycle Template Editor.</td>
</tr>
</tbody>
</table>

**Table 4.4  SAS Model Manager Java Services Capabilities**

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Service: Create a workflow instance</td>
<td>Users or groups associated with a usage role that has this capability can create a workflow instance.</td>
</tr>
<tr>
<td></td>
<td>This role is assigned to the Model Manager: Administration Usage role by default.</td>
</tr>
<tr>
<td>Job Execution Service: Refresh job logs</td>
<td>Provides access to all plug-ins in SAS Management Console.</td>
</tr>
<tr>
<td></td>
<td>This role is assigned to the group SAS Administrators.</td>
</tr>
</tbody>
</table>

For more information about SAS Model Manager tasks that are associated with each role, see the *SAS Model Manager: User's Guide*.

**Create a New User**

Before creating users for SAS Model Manager, you need to define these users on your network domains with valid user IDs and passwords. SAS Management Console helps you create users by using the New User wizard. You can click Help anytime to get information about the current window properties.

To create a new user:

2. Enter the name of the user on the General tab.

   The Display Name, Job Title, and Description are optional.

   **CAUTION:**
   
   Do not use spaces or special characters in the name of a user, group, or role.

3. Provide an e-mail address for the user to receive e-mail notifications from the SAS Publishing Framework. Click the E-mail tab on the lower panel and then click New. The E-mail Properties dialog box appears.

4. Enter SMTP in the **Type** field and the user's e-mail address in the **Address** field. Click OK.
5. Click the **Group and Roles** tab if you want this user to be included in a specified group. Use the arrow button to add the new user to a group.

6. Click the **Accounts** tab and select **New**.

7. Enter the **User ID**, **Password**, and the **Authentication Domain**. Click **New** to create a new valid domain. Enter a name and description for the new domain, and then click **OK** twice to add the new account.

8. (Optional) Click the **Authorization** tab if you want to add users or groups that can view and modify the metadata of this group. It is recommended that you specify authorizations for group level and not user level.

9. Click **OK**.

   The newly created user is displayed with all the other users when the User Manager object is selected from the SAS Management Console navigation tree.

10. In a Windows environment grant the new user permissions for the user rights assignment of **Log on as a batch job** for local security policies on the machine that hosts the SAS Workspace Server.
Create a New User Group

To create a user group:


2. Enter the name of the group on the General tab. The other fields are optional.

3. Click the Members tab. From the Available Identities list, select the users to be included in this group. Select the user name from the Available Identities list and click the arrow button to add it to the Current Members list.
4. (Optional) Select the **Groups and Roles** tab if you want this user group to be included in a specified group.

5. (Optional) Select the **Accounts** tab. You might need this to create the New Login Properties for users who were not defined previously.

6. (Optional) Click the **Authorization** tab if you want to add users or groups that can view and modify the metadata of this group.

7. Click **OK**.

   The newly created group name is displayed with all the other groups when the User Manager object is selected from the SAS Management Console navigation tree.

---

**Create a New Role**

To create a new role:

1. In SAS Management Console, right-click **User Manager** from the **Plug-ins** tab, and select **New ⇒ Role**. The New Role Properties window appears.
2. Enter the name of the role on the General tab. The other fields are optional.

3. Click the Members tab. From the Available Identities list, select the users and groups to assign to this role. Select the user or group name from the Available Identities list and click the arrow button to add it to the Current Members list.
4. Click the **Capabilities** tab. Expand the tree nodes, and then select the check boxes to assign capabilities to the role.

5. Click the **Contributing Roles** tab to give this role all of the capabilities of one or more other roles. Use the arrows to add the new user to a group.

   **Note:** Changes that you make to a role's capabilities affect any roles with which that role is associated.

6. (Optional) Click the **Authorization** tab if you want to add users or groups that can view and modify the metadata of this role.

7. Click **OK**.

   The newly created role name is displayed with all the other roles when the **User Manager** object is selected from the SAS Management Console navigation tree.

---

**Configuring Alert Notifications for SAS Workflow**

To enable workflow participants to receive alert notifications from SAS Workflow, you must configure the **E-mail** notification type in SAS Management Console. After you have configured the alert notifications, you can then use the Notify Participant policy and other workflow notification policies for workflow process activities in SAS Workflow Studio. The notifications setting in SAS Management Console is a global setting. Preferences and notifications can also be configured for individual users.
The Send Notification By Data Object policy in SAS Workflow Studio integrates with the SAS Web Infrastructure Platform's Notification Service. Recipients are notified according to their preferences (e-mail or portlets).

1. Log on to SAS Management Console as an administrator.
2. On the Plug-ins tab, navigate to Application Management ➔ Configuration Manager ➔ SAS Application Infrastructure.
3. Right-click SAS Application Infrastructure and select Properties.
4. Click the Settings tab.
5. Select Notifications in the left panel. Use the menus or text fields to set the property.
6. Select the E-mail notification type.
7. Click OK.
8. To apply this setting and make it available, restart the SAS Web Infrastructure Platform Services, SAS Shared Services, and applications using SAS Workflow.

For more information about the notification properties, see “Setting Global Properties for SAS Applications” in Chapter 7 of SAS Intelligence Platform: Middle-Tier Administration Guide. For more information about setting the notification policies for SAS Workflow, see the SAS Workflow Studio Help or the SAS Workflow Studio: User's Guide.

Create Model Manager Libraries in SAS Management Console

To create a new SAS library in SAS Management Console:

1. Start SAS Management Console and connect to your preferred SAS Metadata Repository.
2. In the SAS Management Console tree, expand Environment Management ➔ Data Library Manager ➔ Libraries.
4. In the folder display, ensure that the folders are expanded for **Resource Templates** ⇒ **Libraries** ⇒ **SAS Data**. Select **SAS BASEMy Library** and then click **Next**.

   *Note:* If you want to register tables from a database, especially for High-Performance Analytics procedure, you can select the Teradata Library or Greenplum Library, instead of the SAS BASE Library. For more information about creating database tables, see the SAS Management Console Help.

5. Enter a name, description, and location for your new SAS library, and then click **Next**. Add an optional description.

6. (Optional) Select the SAS server where the new library is to be assigned, and then click **Next**.

7. Enter a unique SAS library reference name of eight characters or fewer. You will use the SAS libref to access the table.
8. Use the arrow controls to choose a path from the Path Specification Available items box, or click New to specify a new path for your library. Afterward your library path specification appears in the Path Specification Selected Items list. Click Next.

9. Review the summary of the information that you entered, and if it is correct, click Finish.

Your SAS Library appears in the SAS Management Console SAS Libraries list. It has been added to the SAS Metadata Repository. Now you can view your new SAS library in SAS Model Manager. For more information, see “Verify Accessibility of Data Tables in SAS Model Manager” on page 50.

Creating a New Table Using SAS

Here are two examples of how to create a new table by submitting SAS code. The first example creates a table based on another existing table. The second example shows how to create a new empty table.

If you submit the example code below to SAS, make sure that the directory path that is specified in the LIBNAME statement exists. Before you submit the code in Example 1, you need to verify that the appdata.sas7bdat file exists in the specified LIBNAME directory. After the code from the examples is submitted to SAS, two new .sas7bdat files will be created on disk at the location c:\smmwork.

Example Code 4.1  Create a New Table from an Existing Table

LIBNAME smmwork 'c:\smmwork';
   data smmwork.PROJECTIN;
   set smmwork.appdata;
keep age numCards everDefault;
if _N_>1 then stop;
run;

Example Code 4.2  Create a New Empty Table
LIBNAME smmwork 'c:\smmwork';
data smmwork.PROJECTOUT;
length posterior 8 prediction $1;
posterior=.; prediction='';
run;

Registering a Table Using SAS Management Console

Overview of Registering a Table

After you create your data tables, you must register them in a SAS Metadata Repository so that the SAS Model Manager can locate them. SAS Model Manager can add data tables from the SAS Metadata Repository that are registered in SAS Management Console. You register tables in SAS Management Console in the Data Library Manager, Libraries folder.

How to Register a Table

The Register Tables wizard guides you through the process of importing and registering a SAS table in the SAS Metadata Repository. Each library type has a different Register Tables wizard that is called from the Data Library Manager.

Note: The Register Tables wizard is not available on UNIX platforms.

To import and register a table into a SAS Management Console Data Library:

1. Copy the .sas7bdat file for your table into the directory path on the Workspace server that you provided in the Path Specification data field of the New Library Wizard. For more information, see “Create Model Manager Libraries in SAS Management Console” on page 44.

2. Start SAS Management Console, and connect to the SAS Metadata Repository that contains your new SAS Library.

3. In the SAS Management Console tree, expand the following folders:

   Environment Management ⇒ Data Library Manager ⇒ Libraries

4. Right-click the SAS Library name that you want to import your table into, and then select Register Tables from the pop-up menu. The Register Tables wizard window appears.
5. Verify that the information that is displayed in the **Select a SAS Library** page is correct, and then click **Next**.

6. If prompted, enter your SAS user ID and password to log on to your SAS server.

7. The Default Application Server dialog box might appear if the selected folder location is **User Folders** or if a default application server has not been previously selected. Select your SAS server, click **Test Connection** to verify that the connection to the server is successful, and then click **OK**.

8. The Define Tables and Select Folder Location page is displayed. Select the table or tables that you want to register, and then click **Next**.
9. Click Finish.

The metadata for the imported table is written into the SAS Metadata Repository and is associated with the selected SAS Library.

Note: You must create folders with appropriate access permissions so that users can manage their models, create reports, and publish model updates. If a SAS Model Manager user does not have the appropriate permissions to access a folder, then the tables and libraries are not listed in the Data Sources perspective of SAS Model Manager. For more information about creating a folder and setting permissions, see the SAS Management Console Help.

See Also

“Create Model Manager Libraries in SAS Management Console” on page 44
Verify Accessibility of Data Tables in SAS Model Manager

To verify that your new library and associated tables are accessible in SAS Model Manager:

1. Start SAS Model Manager and select the Data Sources category view.
2. Expand the SAS Folders node and navigate to the location of the folder that you selected to store your registered tables, when creating your new library.
3. Expand the folder and verify that the metadata tables that are associated with your new SAS library are displayed.
4. Select a metadata table to view the associated columns and data in the Details pane.

For more information about data sources in SAS Model Manager, see the SAS Model Manager: User's Guide.
Chapter 5
Creating and Configuring Publication Channels

Overview of Creating and Configuring Publication Channels

SAS Model Manager uses the SAS Publishing Framework to publish model updates to an operational environment for testing and production. The SAS Administrator creates and configures definitions for channels, content subscribers, and group subscribers. Then the user can use the SAS Model Manager model extraction macros or user-written SAS code to retrieve and deploy the updated models to the operational environment.

As shown in the following figure, several tasks are necessary to configure and use the SAS Model Manager publishing functionality.
Here are the tasks.

1. The SAS Model Manager administrator creates either an archive or a WebDAV persistent storage location for channels that is accessible from the SAS Workspace Server.

2. The SAS Model Manager administrator creates SAS Model Manager users, HTTP servers, content subscribers, and channels using SAS Management Console.

3. The SAS Model Manager administrator or an advanced user publishes models using the SAS Model Manager Client.

4. The content subscriber (for example, Scoring personnel) receives an e-mail notification from the SAS Model Manager Server that contains a channel content update.

5. The content subscriber extracts models from a channel (for example, on a SAS Content Server) to prepare them for scoring.

Note: SAS Management Console Help provides details for your SAS Model Manager publishing configuration options.

It is recommended that at first you use channels that have the Archive File type for the persistent storage option. This is the simplest channel definition and configuration to use.
Define an HTTP or HTTPS Server

The SAS Model Manager installation process by default defines a SAS Web Server and a SAS Content Server. Use this process to add additional HTTP or HTTPS servers. A WebDAV-enabled HTTP or HTTPS content server must be defined in SAS Management Console before you can publish to channels from SAS Model Manager. The server is usually a third-party server such as Microsoft Internet Information server or an Apache server.

Note: You must have WriteMetadata permission for a repository in order to define an HTTP or HTTPS content server for that repository.

To define your HTTP or HTTPS content server:

1. Start SAS Management Console. Open your existing connection profile for your server. If your connection profile is not available in the list, see “Configuring a SAS Model Manager Connection Profile for the SAS Metadata Repository” on page 32.

2. From the Plug-ins tab, right-click Server Manager, and then select New Server.

3. Select Resource Templates ⇒ Servers ⇒ Content Servers ⇒ Http Server, and then click Next.

Note: If the HTTP server template is not available, then you must add the resource template. For more information, see the SAS Management Console Help.

4. Enter the name and the description of your HTTP server. Click Next.

5. (Optional) On the server properties page, enter the software version and vendor information for the third-party HTTP or HTTPS server that you are defining.

6. Click New to create base path or paths on your server.

Note: If you have not defined the base path for your HTTP server, see “Define Publish Locations for the SAS Content Server” on page 54.

7. In the Base Path field specify the location of the top-level directory where report content items such as report definitions or image files are stored. (This path must be set up as an alias on the web server.) The Description field is optional.

8. Select the Supports WebDAV option and then click OK to save your settings. The new base path appears in the Base Path(s) field of the server properties page.

9. Click Next.

10. Enter the connection properties for your HTTP server:

   a. Select DefaultAuth from the list. When you click New to create a new domain, a dialog box appears. Enter the name and description of your domain.

   b. Enter the fully qualified name or the IP address of your server.

   c. Enter a port number (for example, 8080 for a web application server).

11. Click Next. The New Server Wizard window displays a summary of the settings for the new server and indicates that you have successfully completed the definition of a new server.
12. Click **Finish**. Your new server is displayed under the **Server Manager** node in the SAS Management Console Navigation Tree.

**See Also**

- SAS Management Console Help
- *SAS Intelligence Platform: Middle-Tier Administration Guide*

---

**Define Publish Locations for the SAS Content Server**

During the SAS Model Manager installation process the **ModelManager**, **sasfolders**, and **sasdav** WebDAV folders are automatically created on the SAS Content Server. You can use the SAS Content Server Administration Console (SCS Admin Console) to create a new publishing location for the WebDAV folder or to control access to an existing WebDAV folder. If you need to define a new WebDAV-enabled HTTP content server after the initial installation of SAS Model Manager, then you must define a publishing location. For more information, see “Define an HTTP or HTTPS Server” on page 53.

*Note:* Although you can add a folder to the **sasfolders** location, the folder that you add is not added to the SAS Metadata Server.

**TIP** The best practice is to add folders to metadata using SAS Management Console.

To define a new publishing location:

1. Access the SAS Content Server Administration console by entering the following URL in your web browser and substituting the server name and port number of your SAS Content Server: `http://server-name:port/SASContentServer/direcontents.jsp`.

   *Note:* The default port number for the SAS Web Application Server is 80.

2. Log on to the console as an unrestricted user (for example, SAS Administrator). The SCS Admin Console window appears.

3. Enter a name for the folder in the text box and then click **Add folder** to create a new location for publishing channels.

4. (Optional) To create a subfolder, select the folder that you created in the previous step, enter a name for the subfolder in the text box, and click **Add folder**.

   *Note:* Use the breadcrumb trail above the list to return to a parent folder.
5. To set permissions for a folder:
   
a. Click the permission icon next to the item that you want to modify. The Permissions page appears.

   b. For each principal that is listed, modify the permissions by changing each permission to Yes or No.

   c. To add more principals to the page, do one of the following:
      
      • If you know the principal's name, enter it in the field and click Save changes.
      
      • Click Search for Principals to search for a name. When you find the principal that you want to add, select the check box that is next to the principal's name and then click Return.

      After the principal's name appears on the permission page, you can set permissions for the principal.

      Note: For more information about administering the SAS Content Server, see the SAS 9.4 Intelligence Platform: Web Application Administration Guide.

---

## Configuring Channels and Subscribers for SAS Model Manager

### Overview of Configuring Channels and Subscribers

The Publishing Framework plug-in to SAS Management Console enables you to administer the Publishing Framework.

**Note:** You need to verify that Publishing Framework plug-ins are available in your SAS Management Console navigation tree. If the plug-in is not available, you need to install SAS Foundation Services 1.3 or later so that you can configure your channels and subscribers for SAS Model Manager.

With the Publishing Framework plug-in, you can manage subscribers and channels. For more information, see the Help.

When the Publishing Framework plug-in is available, the SAS Management Console Project Tree should look as follows:
The SAS Metadata Server (for example, *Foundation*) that is shown under the Publishing Framework plug-in contains the **Subscribers** folder and the **Channels** folder.

The Publishing Framework plug-in to SAS Management Console provides wizards that enable you to create subscribers. When you create a subscriber with a wizard, the subscriber object that has the specified attributes is stored on the SAS Metadata Server.

For more information about Publishing Framework, see the *SAS 9.4 Publishing Framework: Developer’s Guide*.

### Channel to Subscriber Configuration

There are several ways to configure channels to publish your models to the SAS Model Manager channel subscribers.

Choose one of these options to define the method to use for publishing channels:

1. **None** - specifies to publish all content that is published to the channel directly to the subscribers (through e-mail). The content is not persisted.

2. **Archive** - specifies a path and an optional logical server for the location of the persistent storage. The *Archive File* option is recommended for publishing model packages. Publishing Framework publishes the content as an archive (binary) SPK (SAS package) file to the persistent storage location.

3. **WebDAV** - specifies the WebDAV server location.

   **Tip**  
   The best practice is to use the *Archive File* type for channel persistent storage and *e-mail* for subscriber notification.

Before publishing models using SAS Model Manager, you must create channels and subscribers to publish your model updates.
Creating Channels and Subscribers

The channel sends the information from the publishers to the subscribers who want it.

A subscriber is a person or a program that has a need for information that is published. To receive information from a channel, the user must be defined as a subscriber.

The Publishing Framework plug-in provides wizards that enable you to create subscribers. Information about the subscriber is stored on the SAS Metadata Server.

*Note:* Channel subscribers must be users of the SAS Metadata Server and their e-mail addresses must be specified.

Create a Channel Folder

If you expect to create a large number of channels, then consider grouping related channels into channel folders. You can create subfolders within folders, thereby creating a folder hierarchy to which access controls can be applied. For more information, see the SAS Management Console Help.

*Note:* Currently it is not possible to move an existing channel into a folder or from one folder to another. Plan ahead to avoid having to delete and re-create channels.

To create channel folders:

1. From the SAS Management Console navigation tree, expand the **Publishing Framework** node.
2. Select and expand the desired metadata repository node.
3. If you are creating a top-level folder, then select **Channels**. If you are creating a subfolder, then navigate to and select the desired parent folder.
4. Right-click Channels and then select New Folder.
5. Enter a name for the new channel folder and then click Next. The new folder is created and the metadata definition information is displayed.
6. Click Finish.

---

Create a New Channel

To create a new channel:
1. From the SAS Management Console navigation tree, expand the Publishing Framework node.
2. Select and expand the desired metadata repository node.
3. If you are creating a channel within a folder, select the Channels node and navigate to the desired folder.
4. Right-click Channels or the desired channel folder and select New Channel.
5. Specify the name of your channel and click Next.
6. Use the arrow button to associate content subscribers with this channel to be notified at publish time. Click Next.
7. Select Archive.
8. Select File for Archive Type and enter the path of your publish location. Click Next.

   The information window appears, providing a summary of the input and status of successful completion of the channel creation.

   Note: The Archive storage has two other types, HTTP and FTP, that you can select from the list.
9. Click Finish. The new channel name is displayed under the Channels node of SAS Management Console.

For more information, see the SAS Management Console Help or the SAS 9.4 Publishing Framework: Developer's Guide.

---

Create a New Subscriber

SAS Model Manager supports only the content subscriber and the Name/Value pair filter for filtering. You can publish to a channel even when the channel does not have any associated subscribers. SAS Model Manager users can extract contents from a channel if they are not subscribers of the channel. However, only subscribers of a channel can receive notifications. You can also create a subscriber group that contains individual subscribers or other subscriber groups. For more information, see the SAS Management Console Help.

To create a new content subscriber:
1. Expand the Publishing Framework node in the SAS Management Console navigation tree.
2. Select the desired metadata repository node.
3. Select **Subscribers ➔ Content Subscribers**.

   ![Diagram showing the navigation path to Content Subscribers]

4. Right-click **Content Subscribers** and select **New Content Subscriber**.

5. Specify a name and a description for this subscriber. The name must be unique within its parent folder. The description is optional. Click **Next**.

6. Click **Select** to associate a person with this subscriber.

7. The search filter enables you to search the repository for users whose names either contain or are equal to a string that you specify. Enter the string in the text field, select either **contains** or **equals** from the list, and click **Search**. A list of users whose names meet your search criteria appears in the **Available People** list.

8. If the desired user does not exist in the repository, then click **New User** to define that user. Then, select the desired user from the **Available People** list and click **OK**.

9. Click **Next**.

10. Select the subscriber's delivery transport and then specify the attributes. Click **Next**.

11. Specify one or more filters to eliminate content that the subscriber does not want to receive. To add a filter, click the tab that corresponds to the type of filter (Name/Value, Entry, or MIME Type). Select **Inclusion** or **Exclusion** and then click **Add** to specify the filter criteria.

12. Click **Next**.

13. Review the subscriber specifications. Click **Back** to make any corrections. Click **Finish** when you are satisfied with your selections.

For more information, see the Help or the *SAS 9.4 Publishing Framework: Developer's Guide*. 
Modify an Existing Channel or Channels Node Location

Modify the Directory Location for the Channels Node

To change the location of the application channels directory, follow these steps:

1. From SAS Management Console, expand the Application Management node on the Plug-ins tab.
2. Select and expand Configuration Manager ➔ SAS Application Infrastructure ➔ Model Manager JavaSvcs 12.3.
3. Right-click Model Manager JavaSvcs 12.3 and select Properties.
4. Click the Advanced tab to modify the application channels directory. Change the property value for App.ChannelDir to a directory that is accessible by the SAS Workspace Server.
5. Click OK.

Modify the Persistent Store Directory Location for a Channel

To modify the location of the persistent store directory path for a channel:

1. From the SAS Management Console navigation tree, expand the Publishing Framework node.
2. Select and expand the desired metadata repository node.
3. If you are modifying a channel within a folder, select the Channels node and navigate to the desired folder.
4. Right-click the name of the channel that you want to modify, and then select Properties.
5. Click the Persistent Store tab, and modify the archive file path and server location.
6. Click OK.

See Also

SAS Management Console Help
Overview of Managing Data Tables, Users, Groups, and Roles in SAS Management Console

SAS Management Console is the primary tool that is available to administer the SAS Metadata Repository. SAS Management Console is a framework that provides a variety of plug-ins that expand the capability of SAS Management Console. Only certain users can view and use plug-ins. A user’s access to plug-ins depends on which roles the user is assigned to and which capabilities are assigned to those roles. SAS Model Manager makes extensive use of the SAS Metadata Repository. Therefore, SAS Management Console is used to perform a number of administrative tasks. Some of those tasks include managing users, groups, roles, and data tables. For information about other administrative tasks such as creating users, groups, roles, and channels, see Chapter 4, “Setting Up SAS Management Console for Use,” on page 31.

For information about SAS Management Console and plug-ins, see Chapter 2, “Understanding the State of Your System,” in SAS Intelligence Platform: System Administration Guide. Also, see the SAS Management Console Help.

Modifying a Data Table

SAS Model Manager does not provide a way to modify the structure of a data source table. If a data source table is modified externally (using SAS Management Console, for example), then the existing SAS Model Manager scoring tasks might stop functioning.

For more information, see SAS Management Console Help or the SAS Intelligence Platform: System Administration Guide.
Deleting a Data Table

Overview of Deleting a Data Table

Data tables can be deleted only from the SAS Metadata Repository using SAS Management Console. Data tables cannot be deleted from SAS Model Manager using the Data Sources view. If the data table's metadata is deleted from the SAS Metadata Repository using SAS Management Console or the operating system, SAS Model Manager cannot access the data table to view data or to perform any reporting or scoring tasks. In this case, an error message appears.

Note: Only a SAS Administrator or a user with Delete permission can delete data tables using SAS Management Console.

Delete a Data Table in SAS Management Console

To delete a data table in SAS Management Console:

3. Select the library that contains the data table that you want to delete.
4. Right-click the data table name in the right pane, and then select Delete from the pop-up menu.
5. Click OK to delete the data table. The data table is removed from the SAS Metadata Repository library, but it is not physically removed from the operating system.

For more information, see SAS Management Console Help or the SAS Intelligence Platform: System Administration Guide.

Managing Users, Groups, and Roles

You use SAS Management Console to set up users, groups, and roles to define which actions a user can perform when using SAS Model Manager. For information about setting up a user, group, or role, see “Configuring Users, Groups, and Roles” on page 34.

In order to make access distinctions and track user activity, security systems must know who is making each request. The primary purpose of user administration is to provide information that helps systems make this determination. The SAS environment requires one external account ID for each user. The SAS environment then uses its copy of these IDs to establish a unique SAS metadata identity for each connecting user. All of a user's group memberships, role memberships, and permission assignments are ultimately tied to their SAS metadata identity.

To access user administration features in SAS Management Console, select the User Manager node on the Plug-ins tab. Your roles and permissions determine which user administration tasks you can perform.
Note: The User Manager node is the only location from which you can manage identities.

For more information, see the SAS Management Console Help or the SAS Intelligence Platform: System Administration Guide.
Glossary

activity
See task

activity status
See task status

candidate model
a predictive model that evaluates a model's predictive power as compared with the champion model's predictive power.

counterpart model
a model that is compared and assessed against a champion model for the purpose of replacing the champion model in a production scoring environment.

champion model
the best predictive model that is chosen from a pool of candidate models in a data mining environment.

channel
a virtual communication path for distributing information. In SAS, a channel is identified with a particular topic. Using the features of the Publishing Framework, authorized users or applications can publish digital content to the channel, and authorized users and applications can subscribe to the channel in order to receive the content.

classification model
a predictive model that has a categorical, ordinal, or binary target.

data object
an object that holds the business data that is required to execute workflow tasks.

data set
See SAS data set

data source
a table, view, or file from which you will extract information. Sources can be in any format that SAS can access, on any supported hardware platform. The metadata for a source is typically an input to a job.
DATA step
in a SAS program, a group of statements that begins with a DATA statement and that ends with either a RUN statement, another DATA statement, a PROC statement, or the end of the job. The DATA step enables you to read raw data or other SAS data sets and to create SAS data sets.

DATA step fragment
a block of SAS code that does not begin with a DATA statement. In SAS Model Manager, all SAS Enterprise Miner models use DATA step fragments in their score code.

delta report
a report that compares the input and output variable attributes for each of the variables that are used to score two candidate models.

identity
See metadata identity

input variable
a variable that is used in a data mining process to predict the value of one or more target variables.

instance
See workflow instance

library reference
See libref

libref
a SAS name that is associated with the location of a SAS library. For example, in the name MYLIB.MYFILE, MYLIB is the libref, and MYFILE is a file in the SAS library.

metadata
descriptive data about data that is stored and managed in a database, in order to facilitate access to captured and archived data for further use.

metadata identity
a metadata object that represents an individual user or a group of users in a SAS metadata environment. Each individual and group that accesses secured resources on a SAS Metadata Server should have a unique metadata identity within that server.

milestone
a collection of tasks that complete a significant event. The significant event can occur either in the process of selecting a champion model, or in the process of monitoring a champion model that is in a production environment.

model function
the type of statistical model, such as classification, prediction, or segmentation.

model scoring
the process of applying a model to new data in order to compute outputs.

output variable
in a data mining process, a variable that is computed from the input variables as a prediction of the value of a target variable.
**package**
See SAS package file

**package file**
See SAS package file

**participant**
a user, group, or role that is assigned to a task. These users, groups, and roles are defined in SAS metadata and are mapped to standard roles for the workflow.

**policy**
a workflow element that associates event-driven logic with a task or subflow. Policies are usually triggered automatically by an event such as a status change or a timer event.

**prediction model**
a model that predicts the outcome of an interval target.

**project**
a collection of models, SAS programs, data tables, scoring tasks, life cycle data, and reporting documents.

**project tree**
a hierarchical structure made up of folders and nodes that are related to a single folder or node one level above it and to zero, one, or more folders or nodes one level below it.

**publication channel**
an information repository that has been established using the SAS Publishing Framework and that can be used to publish information to users and applications.

**publish**
to deliver electronic information to one or more destinations. These destinations can include e-mail addresses, message queues, publication channels and subscribers, WebDAV-compliant servers, and archive locations.

**Publishing Framework**
a component of SAS Integration Technologies that enables both users and applications to publish SAS files (including data sets, catalogs, and database views), and other digital content to a variety of destinations. The Publishing Framework also provides tools that enable both users and applications to receive and process published information.

**SAS Content Server**
a server that stores digital content (such as documents, reports, and images) that is created and used by SAS client applications. To interact with the server, clients use WebDAV-based protocols for access, versioning, collaboration, security, and searching.

**SAS data set**
a file whose contents are in one of the native SAS file formats. There are two types of SAS data sets: SAS data files and SAS data views.

**SAS Metadata Repository**
a container for metadata that is managed by the SAS Metadata Server.
SAS Metadata Server
a multi-user server that enables users to read metadata from or write metadata to one or more SAS Metadata Repositories.

SAS package file
a container for data that has been generated or collected for delivery to consumers by the SAS Publishing Framework. Packages can contain SAS files, binary files, HTML files, URLs, text files, viewer files, and metadata.

SAS publication channel
See publication channel

SAS variable
a column in a SAS data set or in a SAS data view. The data values for each variable describe a single characteristic for all observations (rows).

scoring
See model scoring

scoring function
a user-defined function that is created by the SAS Scoring Accelerator from a scoring model and that is deployed inside the database.

scoring task
a workflow that executes a model's score code.

segmentation model
a model that identifies and forms segments, or clusters, of individual observations that are associated with an attribute of interest.

source
See data source

SPK
See SAS package file

subscriber
a recipient of information that is published to a SAS publication channel.

swimlane
a workflow diagram element that enables you to group tasks that are assigned to the same participant.

task
a workflow element that associates executable logic with an event such as a status change or timer event.

task status
the outcome of a task in a workflow. The status of a task (for example, Started, Canceled, Accepted) is typically used to trigger the next task.

variable
See SAS variable
**version folder**
a folder in the Project Tree that typically represents a time phase and that contains models, scoring tasks, life cycle data, reports, documents, resources, and model performance output.

**WebDAV server**
an HTTP server that supports the collaborative authoring of documents that are located on the server. The server supports the locking of documents, so that multiple authors cannot make changes to a document at the same time. It also associates metadata with documents in order to facilitate searching. The SAS business intelligence applications use this type of server primarily as a report repository. Common WebDAV servers include the Apache HTTP Server (with its WebDAV modules enabled), Xythos Software's WebFile Server, and Microsoft Corporation's Internet Information Server (IIS).

**workflow**
a series of tasks, together with the participants and the logic that is required to execute the tasks. A workflow includes policies, status values, and data objects.

**workflow definition**
a workflow template that has been uploaded to the server and activated. Workflow definitions are used by the SAS Workflow Engine to create new workflow instances.

**workflow instance**
a workflow that is running in the SAS Workflow Engine. After a workflow template is uploaded to the server and activated, client applications can use the template to create and run a new copy of the workflow definition. Each new copy is a workflow instance.

**workflow template**
a model of a workflow that has been saved to an XML file.
administrative user account recommendations 4
preparing SAS Model Manager for use 7
public directories
creating on SAS Content Server 9
publication channels
Archive File type 52
configuring 51
creating channel folders 57
creating new channels 58
creating new subscribers 58
MMChannel 52
Publishing Framework plug-ins 33, 55

storing table metadata 31
SAS Model Manager database configuration 5
SAS package files
See SPK files
SAS Publishing Framework 51
See also Publishing Framework plug-ins
scoring result set
limit number of observations 22
SPK files
registering a model SPK file 9
subscribers to channels, creating 58

R
registration
of model SPK files 9
of tables 47
roles
configuring 34
creating new roles 41
managing 61, 62

T
tables
creating with SAS code 46
deleting 62
managing 61
modifying 61
registering 47
verifying accessibility 50

U
user accounts
create 3
users of SAS Model Manager 3
User Manager plug-in 62
users
configuring 34
creating new users 37
managing 61, 62

V
verification
SAS Model Manager 8
table accessibility 50

W
WebDAV folders
creating as publishing locations 54
Windows
Log on as a batch job 4
workflow
configuring 22

S
SAS Application Server
defining 12
SAS Content Server
accessing the Administration Console 9
creating a public directory 9
defining publish locations 54
SAS Enterprise Miner
using SAS Model Manager with 9
SAS environment file
determine location 5
SAS Management Console 61
access to plug-ins 61
creating libraries in 44
managing tables, users, groups, and roles 61
Publishing Framework plug-ins 33, 55
registering tables 47
setting up for SAS Model Manager use 31
User Manager plug-in 62
SAS Metadata Repository
configuring 10
connection profiles 32